
User guide 
Version 1.0 

TABLE of CONTENTS
Welcome to Aurora HDR 2017! 2 ..................................................................................
Key features and benefits of Aurora HDR  3 ....................................................................
Key new & improved features of Aurora HDR 2017 3 .......................................................
Activating Aurora HDR 2017 4 ......................................................................................
Installing Aurora HDR 2017 as a Plugin 4 .......................................................................
Starting with Aurora HDR 2017 10 ................................................................................
User interface overview 12 ..........................................................................................
Top toolbar overview 14 ..............................................................................................
Info panel overview 17 ................................................................................................
The Side Bar 18 .........................................................................................................
Batch Processing 57 ....................................................................................................
Finishing Options 61 ...................................................................................................
Extra Features 64 .......................................................................................................
Keyboard Shortcuts 66 ................................................................................................
Keeping Aurora HDR Pro up to date! 67.........................................................................

Page !  of !1 67



Welcome to Aurora HDR 2017! 

Aurora HDR 2017 is a joint project between Macphun and Trey Ratcliff to produce the 
ultimate HDR software in the world. 

Macphun is one of the world’s leading developers of consumer and professional 
photography software, serving over 35 million customers worldwide. All of the company’s 
software is made exclusively for Mac. 

Trey Ratcliff is a photographer, artist, writer and adventurer with over 14 million fans 
around the world who regularly follow his exploits and seek photographic education and 
inspiration from his work. He is one of the world’s pre-eminent HDR photographers, his 
images have been viewed on the Internet over 115 billion times. 

Using Trey’s vast experience with the current tools in the market, and advanced 
technology from Macphun, we have jointly created state-of-the-art software to help 
photographers of all skill levels make amazing images. 
  
Aurora HDR 2017 contains every imaginable tool needed to produce high-quality “next 
generation” dramatic images, as well as Presets and video training developed by Trey and 
other Pro photographers that will appeal to every photographer. 
  
The original version of the software launched November 19, 2015 and earned accolades 
from every corner of the globe, including Mac App Store “Best of 2015” honors. The new 
version will launch on September 29, 2016 and will initially be sold in only one variation 
that includes all features including the ability to run standalone as well as a plug-in to 
popular host applications. The software will be sold simultaneously on the Mac App Store, 
as well as the Stuck in Customs and Macphun websites. 

__________________________________________________ 

What is HDR?

High Dynamic Range (HDR) photography is a popular photographic technique designed to 
overcome the limitations of image sensors in digital photographs. This process utilizes 
multiple exposures of the same subject, each shot at different exposure values 
(“brackets”). Those are then automatically merged into a single shot which encompasses 
a greater exposure range. 
__________________________________________________ 
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Key features and benefits of Aurora HDR  

• Revolutionary HDR algorithms make possible the entire spectrum of HDR looks, 
from natural to highly stylized. 

• Total HDR editing experience with the most complete set of tools available. 
• Powerful one-click presets, including Signature Pro presets by Trey Ratcliff, Captain 

Kimo and others, yield fantastic results instantly. 
• Layers, brushes and masking provide the ultimate in selective editing. 
• Luminosity masks, selective via the Zone System, provide extensive fine-tuning 

control 
• Unique Radiance and Glow controls and custom texture blending for creative 

versatility.  
• Detail enhancement to increase drama in images. 
• Extensive color and toning controls for vibrant color combinations. 
• Batch processing which auto-detects brackets. 
• Modern user interface design makes for a comfortable, understandable experience. 
• Built-in sharing supports popular photo communities and social networks. 
• RAW, JPG, TIFF and other popular files support for the greatest flexibility. 
• Workflow tailored to any style with support for using as a standalone app or as a 

plug-in to popular host applications. 

Key new & improved features of Aurora HDR 2017 

• NEW - Polarise Filter. 
• NEW - Powerful Zone System for Luminosity masks. 
• NEW - Feather & Density brush parameters for layer masks. 
• NEW - Radial Masking tool. 
• NEW - Batch Processing, including including automatic recognition of brackets, 

support for sub-folders and Batch presets. 
• NEW - Top & Bottom Adjustment controls. Replaces Top & Bottom Lighting 
• NEW - Image Resize/Sharpen on export.  
• IMPROVED - Support of different Blend modes for Layers and Textures. Added 

Darken, Color Burn and Lighten 
• IMPROVED - Advanced Tone Mapping controls. Better recovery of "washed" 

highlights. 
• IMPROVED - Color Temperature tool. Produces more realistic results 
• IMPROVED - Advanced Structure & Clarity technology for better sharpening. 
• IMPROVED - Color Filter/Selective Color tool. Added Hue adjustments 
• IMPROVED - Over 70 categorized HDR presets, including new sets from Trey 

Ratcliff, Serge Ramelli & Captain Kimo 
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• IMPROVED - Gradient Masking tool. 
• IMPROVED - Native RAW files support, including better DNG handling.  
• IMPROVED - Reduced noise and better color rendering on initial tone-map 
• IMPROVED - Open HDR dialog. Added ability to remove images from exposure 

series prior to merging. Improved alignment. Increased speed of merging. 
• IMPROVED - Revolutionary tone-mapping technology. Reduced introduction of 

noise, improved realism of initial results 
• IMPROVED - Overall application speed. 
• IMPROVED - Layer masking painting performance increased by 50% 
• IMPROVED - User interface. Cleaner, more modern style. 
• IMPROVED - Maximum zoom level increased to 3000%. 

Activating Aurora HDR 2017 

After installation, launch Aurora HDR for the first time to view a Welcome screen. If you 
wish to run Aurora HDR 2017 in Trial mode, simply click the Demo button. You’ll be able 
to use all functions of Aurora HDR except for those operations related to saving, 
exporting or sharing — it’s a great way to see what Aurora HDR can do for your images!  

To purchase the software, click the Purchase button in the center of the window and a 
web page will open to our shopping cart. Once you’ve purchased the software, click on 
the Activate button in the Welcome screen and enter your activation key and email 
address. If you ever lose your activation key, you’ll be able to provide our support team 
with your email address and they can restore the activation code for you.

Installing Aurora HDR 2017 as a Plugin 
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Aurora HDR 2017 can be run as an incredible stand alone application, but you can also 
install it and run as a plug-in for other popular photo editing software. During the initial 
installation you should be prompted to install the plug-ins for detected software you 
already have installed. If you need to update or reinstall, you can access the installation 
dialogue from the file menu on your Mac when Aurora HDR 2017 is open.  Simply choose 
the Aurora HDR 2017 -> Install Plugins… menu to start. 

The resulting dialog box will allow you to see which host applications you have currently 
installed on your Mac, and then select from which you’d like to install.  The host 
applications supported by Aurora HDR 2017 are Adobe Photoshop, Adobe Lightroom, 
Adobe Photoshop Elements, and Aperture. Click the Install/Uninstall button for the 
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corresponding apps in which you’d like Aurora HDR 2017 to run. In addition, though it’s 
not listed in this plug-in dialog box, Aurora HDR will operating as an editing extension in 
Photos for Mac. 

You may be prompted to input your Administrator password to complete the installation 
and you’ll want to restart any applications you’ve installed too if they were open.  

Using Aurora HDR 2017 with Adobe Lightroom 

Choose your image(s) in Lightroom that you want to work on with Aurora HDR and Right 

click with your mouse to view the context sensitive menu. Select  Export > Export to 
Aurora HDR 2017. There is also another option to Use .TIFF with Lightroom 
Adjusters if you’ve made adjustments in Lightroom that you want to keep before 
merging.  
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Using Aurora HDR 2017 with Adobe Photoshop / Elements 

To use the software with Photoshop, you’ll need to have a file opened already and choose 
the Filter > Macphun Software > Aurora HDR 2017… menu to begin. 

Just like with Lightroom, this will now launch Aurora HDR 2017 as a plugin and open the 
Load/HDR Merge screen, however, since Photoshop will only open one layer, the only 
options available will be to Remove Chromatic Aberration. This means you cannot 
merge brackets from Photoshop into Aurora HDR 2017. 

Note 
Aurora HDR 2017 can operate as a Smart Filter in Photoshop. If you designate a 
Photoshop layer as a Smart Filter, then launch the Aurora HDR plug-in as normal to 
make edits, when you return to Photoshop you can always double-click on the layer and 
return to Aurora HDR with all edits intact. 
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Using Aurora HDR 2017 with Aperture 

Working with Aurora HDR through Aperture is very similar to the way it behaves with 
Lightroom. Navigate to the files you wish to merge in Aurora HDR, select them, and 
export to Aurora by right-clicking the images in the film strip and selecting Edit with 
Plug-in > Aurora HDR 2017… or through the menus by selecting Photos > Edit with 
Plug-in > Aurora HDR 2017… 

Using Aurora HDR 2017 as a Photos for Mac Extension 

If the version of the macOS system on your Mac is newer than 10.11 you can use Aurora 
HDR 2017 as an extension for Photos. To Install Aurora HDR 2017 in Photos, you have to 
first open Aurora HDR 2017. Then launch Photos and open an image you want to edit. In 
the top-right corner click on the Edit button to reveal Photos’ editing panel.  

At the bottom, click on the button labeled Extensions and select Aurora HDR 2017 to 
begin editing photos.  
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If it is not present in the pop-up menu, click on the More button (3 dots) which will open 
the System Preferences dialog where you’ll be able to add Aurora HDR 2017 by ticking 
the checkbox. Quit System Preferences and Aurora HDR 2017 will now be available as an 
extension in Photos. 
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Starting with Aurora HDR 2017 

Open Images 

Aurora HDR 2017 can open a series of the same images shot with different exposures. A 
series of images with different exposures are commonly known as HDR brackets. Aurora 
HDR 2017 supports any practical number of images in a bracket. In addition, all versions 
can open just a single image which is great for “re-imagining” your back catalog of 
photos. 

The app supports the following image file formats when opening: JPG, TIFF, PNG, RAW, 
DNG formats.  

The open dialog allows you to open a set of sample images or of course use your own. 
You can also choose to open a folder of images for Batch Processing (more on this later). 

When you select an image or images, you will see a preview window with the images 
you plan to process. You’ll also be able to select a variety of automatically applied 
corrections: Alignment (a checkbox on the main preview panel) and Ghost Reduction, 
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Chromatic Aberration Reduction and Color Denoise for RAW files only, all of which are 
accessed by clicking the button Additional Settings in the lower left. 

Creating the Merged HDR Image 

Alignment 

If the photos from HDR bracket were taken by hand (e.g. without a tripod), they may 
differ slightly in alignment. If the Alignment option is checked, the application 
automatically aligns all the images before merging them into a single HDR image. 
Therefore, Aurora HDR 2017 makes it easy to use images from an HDR bracket series, 
even those shot without a tripod. If you open an image from an HDR bracket without 
Alignment, and it is slightly blurred, simply open it again with the Alignment option 
enabled. 

Ghosts Reduction 

If there are moving objects in your HDR brackets — tree leaves, flags, people, etc. — it 
can look a bit unusual after the HDR merge process. The moving object may appear as a 
translucent “ghost.” This is simply because the image information is different on each 
different HDR bracket image (i.e. something has moved through the frame of the photo). 
To minimize this problem, click the Additional Settings button which will reveal a pop-
over panel for enabling Ghosts Reduction. This feature will let you choose a reference 
image from the bracket. The software will then analyze each of the exposures and 
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compare it to the reference image before merging them into a single HDR image. The 
result is that any object that changed positions between exposures will be replaced with 
a static object whose position is selected from one of the images of the bracket.  

Color Denoise  

This feature reduces low-light noise found in color (or “chrominance”) pixels during the 
merging process for RAW files. Access this by clicking on the Additional Settings button 
which will reveal a pop-over panel for enabling Color Denoise. 

Chromatic Aberration Reduction  

This feature analyzes the merged HDR image and minimizes any chromatic aberrations 
which have been detected. These are typically characterized by a slight red or purplish 
glow along the edges of stark contrasting areas in the image. These optical aberrations 
however slight, are always present on any photo and may reduce picture quality. If you 
think that your image may include red or purple glows, click the Additional Settings 
button which will reveal a pop-over panel for enabling Chromatic Aberrations Reduction. 

__________________________________________________ 

ATTENTION! 

Each of these options considerably slows down the creation of your HDR image because 
they requires significant computing resources to analyze the images. In the case of 
Ghosts Reduction, it is also worth noting that this feature may not always work properly 
because of a lack of information to obtain a single static image from a series of moving 
images. Keep this option off and turn it on only when you need to fix apparent problems 
with ghosting. 
__________________________________________________ 

User interface overview 

Working panels overview 

The Aurora HDR 2017 user interface consists of 4 main operating areas. 

Top Toolbar. General-purpose and frequently used functions of the software. 
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Info Bar. This is used to display information about the image when the Move (hand) 
mode is selected. 

When the Paint (brush) mode is selected, the info bar changes to display functions 
related to brushes and masks. 

Side Bar.  
Located to the right of the main image display, all adjustment tools, layers and the 
histogram can be found here. 
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Preset Panel.  
Displays one-click presets at the bottom of the screen. Activate by clicking on the green 
Presets button. 

Top toolbar overview 

The Top toolbar contains many general use or frequently accessed functions, grouped 
logically for easier use.  

1. Open / Batch / Export Buttons.  

The first button that looks like a file folder is used to load new images for 
processing. The second button is opens up the Batch Processing dialog box. The 
final button in this group is used to export an image from the application and save 
it as a graphic file. The same image can also be shared with other editing software 
from Macphun or uploaded directly to social networks and other online services. 

2. Zoom Buttons.  

These buttons are used for changing your view of the image size in the workspace. 
If you go from left to right the buttons do the following. 
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1. Zoom the image closer  
2. Reduce the size of the displayed image  
3. Return the image to its original size (100%) 

Note, at any zoom level other than 100%, the 100% icon will change to an icon 
representing “Fit to Screen” - clicking on this button will reduce the size of the image 
to cover the entire working area. 

3. Comparison Buttons.  

These buttons allow you to compare the original image with the original default 
image, so you can easily compare how your enhancements changes the original 
image.  

The buttons do the following: 

Eye - Quick Comparison Button. If you hold down the button, the original 
image is displayed in the workspace instead of the enhanced version. This 
allows you to quickly compare the current image with the original. This is 
the fastest and most convenient mode of comparison. Press the spacebar as 
a keyboard shortcut to apply this function. Simply push and hold "spacebar" 
for a quick comparison. In the View menu, you can choose to have the 
comparison image be the middle shot of the bracket series, the original 
single image (if you are editing only a single photo) or the original tone 
mapped result.  

Side-by-Side Comparison Button. This button activates a comparison 
where the image is divided by a vertical strip (“curtain”). The original image 
is displayed on the left, and the current result is on the right. This vertical 
strip can be moved left and right, so you can view the differences in the 
picture. You may also click on an icon that depicts the images side-by-side 
in order to compare the original image to the latest enhanced image. 
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4. Crop Button.  

Turns on the picture Crop tool. This feature allows cropping the picture and an 
opportunity to align (straighten) the horizon in the image if it is not horizontal or 
otherwise to your liking.  

5. Undo / Redo Buttons.  

The Undo Button (left arrow) cancels the last action (for example, changing the 
slider), and the button Redo (right arrow) returns the last undo function. 

6. Move / Brush Buttons. 

These operations toggle either the Move or Paint modes - only one of them can be 
chosen at once. 

The Move mode (represented by a Hand icon) means that you can move the image 
when in a zoomed-in state. This is the default mode when the software opens. To 
operate this mode, move your mouse over the main image, then press and hold 
the mouse to move the image on the screen. 

The Paint mode (represented by a Brush icon) will allow you to paint a layer mask 
on the current layer. In this mode, we work with a brush to paint the layer mask. 
By clicking and holding the left mouse button on the image we start to draw in the 
current layer mask. 

When you select the Brush icon, the Info Bar reveals controls related to masking 
and brush options, which will be explained later in this manual. 
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7. Presets / Layers / Histogram Buttons. 

Clicking on the icon that looks like a rectangle with three squares underneath, will show/
hide the Presets Panel. This has the same effect as clicking on the green Presets button 
near the bottom of the Aurora HDR 2017 workspace. 

When you click on the icon that looks like stacked papers, the Layers pane is shown or 
hidden in the side toolbar. 

When you click on the button with the histogram icon, the Histogram pane is displayed or 
hidden in the Side Toolbar. 

Info panel overview 

In the Move mode, the Info Bar provides basic information about the file, as well as the 
zoom percentage. If the button with a brush is activated, the Info Bar shows information 
about the painting and masking functions. In this section we describe the Info Bar 
features in the Move mode. Masking and painting will be described letter. 

Left Info Bar section 

Information about the shooting parameters of the current HDR image is displayed here. 
This information is divided into several sections. Section displays the following 
information (from left to right): 

1. The indicator of the current HDR dynamic range. This indicator shows the exposure 
value (“EV”) of the darkest bracket, then the EV of the middle bracket and finally 
the EV of the brightest bracket, each separated by an ellipses. 

2. The number of images used for the assembly of the HDR. 
3. ISO of the images when captured. 
4. The focal length when shooting brackets 
5. F-stop for the images from this bracket. 
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Middle Info Bar section  

This indicator shows the current zoom. When you click on the down arrow to the right of 
the percentage reading, you can select preset zoom levels. 

Right Info Bar section 

The Info Bar section on the right displays the current resolution of the image in pixels as 
well as the number of bits per pixel. Aurora HDR 2017 operates in 32-bit per pixel mode 
to provide the highest image quality. 

The Side Bar 

The Side Bar on the right side of the Aurora HDR 2017 workspace is where you’ll find all 
of the major features and tools to help you create amazing HDR images. 

It is divided into 4 sections (from top to bottom): 

1. Histogram - Displays a histogram of the current image. 
2. Layers - All functions related to layers. 
3. Tools - Includes all the primary tools and features for enhancing images. 
4. Presets - Houses all of the one-click Presets available in Aurora HDR 2017 and 
described in detail elsewhere in this manual. 
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We’ll discuss each of these powerful features in depth. 

Side Bar: Histogram 

A histogram is a graphical representation of the tonal values of your image. In other 
words, it shows the amount of tones of particular brightness found in your photograph 
ranging from black (0% brightness) to white (100% brightness). Ideally, well balanced 
images will have tonal values across the entire range of the histogram. 

Key Points of the Histogram: 

The histogram is able to display Red, Green, Blue channels separately or, by default, 
shows all of them at once.   

Triangles on the left and right sides allow you to examine absolutely black or white 
pixels.  
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To enable or disable the display mode of absolutely black pixels, click the triangle on the 
left and the histogram is clipped on the left side. Absolutely black pixels will be displayed 
in bright blue in the image.  

Clicking the triangle on the upper right will show where your image is completely white, 
where the histogram is clipped on the right side. Absolutely white pixels are displayed in 
red. 

Side Bar: Layers 

Layers are a powerful way to “build up” your images, with different enhancements and 
use of blending modes on each layer. Using layers, you can apply corrections or 
enhancements on different layers, and experiment until you achieve exactly the look 
you’d like for your image. 
 

• To create a new layer. Click on the + button in the Layers Toolbar header. A small 
pop-up menu will appear giving you the option of creating a layer beginning from one 
of the following 4 options: 

1. Adjustment layer - creates a normal layer to which you can apply a preset or 
any other adjustment in the Tool panel. 
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2. Custom Texture - displays a standard Open File dialog, allowing you to create a 
new layer with a texture file you’ve chosen. 

3. Original Image - creates a new layer with the original tone-mapped image. 
4. HDR Bracket - creates a new layer with your choice of one of the original 

exposure files 

• To remove the layer. Select the layer and click - in the Layers Toolbar title. 

• To change the blending mode of the layer. Set the Layer Blending mode in the 
drop-down list under the word Layers or in the fly-out menu indicated by the horizontal 
stripes icon underneath the + icon. You cannot set the blending mode for the first layer 
because it is not mixed with anything - it is the baseline image.  

Modes of blending: 

1. Normal 
2. Darken 
3. Multiply 
4. Color Burn 
5. Lighten 
6. Screen 
7. Overlay 
8. Soft Light 
9. Hard Light 
10. Color 
11. Luminosity 
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Layer Transparency Setting. Click on the drop-down menu with percentages near the 
word Opacity. Press this button and move the slider to customize the opacity. 

Access Advanced Settings and Functions of the Layer. Click on the Layer Menu 
button with 3 horizontal strips below the + icon. A context menu appears with additional 
features to apply to the layer. 

To Change the Order of Layers. All the layers except the first are movable. Click on 
the layer and hold the mouse to drag the selected layer to the new location. 

Show / Hide the Layer. Click on the orange circle on the left side of the mask layer 
preview icon to toggle between visible and hidden. 

Important  
When you switch to the bottom layer - all of the top layers are off automatically. Hence 
only the current layer and all layers below are always visible.  The orange circle is 
displayed on the left side of visible layer. 

How Layers work 

Unless otherwise chosen, each layer uses the previous layer as it’s starting point. In 
other words, each layer imposes the result of its processing on the previous layer. 

An exception is the use of the selected texture. In this case, the effect is simply the 
selected texture. To show previous layers through a new selected texture, you need to 
erase part of the mask, decrease the opacity of the layer containing a texture or choose 
a blend mode. Otherwise, the top opaque texture completely covers all the lower layers. 

How to Choose a Custom Texture as the Source Image for the Layer 

By default, each top sheet effect is superimposed on the previous layer. But it is possible 
to use the selected texture as a base for a new layer instead of previous layer. A texture 
must be an external file. 

To choose a custom texture from a file for a layer, click the right mouse button on the 
layer to display the contextual menu. Then, choose the Source Image -> Custom 
Texture... After that, you select an image in the Open File dialog that appears. To 
control the texture-mapping mode, you can configure the fly-out menu Texture 
Mapping to Fill the Screen or Scale to Fit. 
 
To change the effect of the texture. You can adjust the blend mode and opacity of the 
layer to make many different creative effects. Each mode will have a different impact on 
your image based on the type and opacity you choose. Adding a texture to your image 
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can dramatically change the look and feel of your work, plus you may want to use a 
brush to apply the texture only in specific areas of your image. 

As mentioned in the previous section, choose from one of 11 blend modes from the Blend 
menu found just below the Layers title or by right-clicking the layer name and selecting 
Blend from the context menu. Adjust the opacity by sliding the Opacity slider of the layer 
ranging from 0-100%. 

Tool Remarks 
Note that textures are not stored in Aurora HDR. These files are located wherever you’ve 
saved them for usage. For easy access, we recommend keeping all of your textures in a 
consistent place on your hard disk. 

How to Choose an HDR bracket as the Source Image for a Layer 

To select one of the HDR bracket images as layer base, click the right-click the mouse 
button on the layer to open the contextual  menu, then select the Source Image menu. 
The resulting fly-out menu will display the names and associated EV of each of the 
images originally used to create the HDR image. Select the exposure you’d like to use as 
the source image. 
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Painting & Masking Mode 

The application always runs in one of two modes - Move Image Mode or Painting Mode. 
To switch modes, use the toolbar buttons at the top: a hand and a brush. 

Move Image Mode 

Move Image Mode works when the Hand button in the top toolbar is the chosen 
(“active”). In this mode, the cursor is used to move the image when in a zoomed in 
state. Click on the central image and the cursor will turn into a hand. Continue pressing 
the mouse button down and move the image until the portion of the image you want to 
examine is in view. In addition, use gestures to navigate macOS. Slide the touchpad with 
two fingers. 

Painting Mode for Creating Masks 

The Painting mode makes it possible to create a layer mask upon which a layer effect will 
be applied. In this way, you can selectively edit the image. In this mode, the cursor turns 
into a brush. Press the left mouse button on the image to begin drawing. 

When you switch to the Painting Mode, the information bar is transformed into a mask 
layer & painting toolbar. 
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Moving left to right, each of these icons and tools will be explained below: 

The “Eye’ icon 
Hides or shows the layer mask. If you click the eye icon, the layer mask appears over the 
image as a red translucent layer. You may also continue drawing while the layer mask is 
shown, for even more precision. 

The Clear Button  
Clears (or resets) the layer mask and the active layer becomes visible. 

Options Button contains additional features related to operating with the layer. The 
button is in the form of 3 stripes and a drop-down arrow icon. It opens a contextual 
menu with additional options for working with the layer. 
 

• Invert 
Inverts any mask that you’ve created. 

• Fill  
Fills the entire layer with a mask. 

• Copy 
Copies the current mask to the clipboard. To use this, create a new layer and paste 
it into the new layer. 

• Paste 
Pastes the current mask stored on the clipboard. 

• Density 
Controls the transparency of pixels outside of a mask so the overall the mask 
fades into the background better. 

• Feather 
Blurs the edges of a mask to more naturally fade the mask adjustments into the 
image. 
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Luminosity Masking… button 
This tool fills the current layer with a Luminosity Mask based on the brightness of image 
pixels, and based on the Zone System. Thus the transparency of the mask corresponds 
to the brightness of the pixel. This is a very powerful tool to mask image selectively. For 
example, if the sky and clouds are bright, you can create an exact mask only for that 
area of the image and then enhance them. 

To create a Luminosity Mask, click on the Luminosity Masking… button in the center of 
the Painting Mode info bar. This will reveal controls specific to Luminosity Masks. 

Clicking on a numeric value representing a tonal range will pre-define a mask of that 
zone. The whole image is divided into 10 tonal zones. From the darkest to the brightest. 

• Values: 0, 1, 2, 3 
• Shadows 
• Values: 4, 5, 6 

Mid-tones 
• Values 7, 8, 9, 10 

Highlights 

Click one or more zones and dramatically enhance your images without brushes or 
complicated selections. Clicking the All button will create a global mask based on the 
brightness (luminosity) of the image pixels. 

Moving left to right, each of these icons and tools will be explained below: 

• “Eye” icon  
Use the “Eye” icon to show and hide the mask. 

• Zone System numbers 
Clicking on a number, multiple numbers or the All button will select the appropriate 
zones. 

• X icon 
Click on the X icon to go out of Luminosity Mask mode. 
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• Checkmark 
Click on the green checkmark to create the mask 

Alternatively, you can open up the Histogram and when you mouse over it, a Zone 
System selection strip will appear. Selecting a zone(s) will reveal a button that allows you 
to create a Luminosity Mask. 

Tool Remarks 
1.  Luminosity Masking tool is ideal for selective editing based on tonal range; it is far 

more accurate than trying to select complex objects any other method. 
2. The edges of masks created in this manner can be made more soft using the 

aforementioned Feather slider to help blend the mask into the background image. 
3. Depending on your enhancements to the mask, if extra noise is generated, simply 

use a brush to apply noise reduction or further effects. 
4. As part of their editing exploration, many photographers will also invert the 

Luminosity mask. 

Painting Management 
This section of the Painting Mode Info Bar controls the creation of masks with a brush. 
 

Paint mode vs. Erase mode 
When selecting the brush icon in the Top Toolbar, by default the brush tool is in the paint 
mode. The circle on the left side of the Brush label when selected (filled in w/ a gold 
color) depicts paint mode. When using this mode, the brush tool will create a mask and 
either (a) apply enhancements that have already been completed, or (b) simply create a 
mask to which future enhancements may be applied. 

Clicking on the hollow circle to the left side of the Brush label will switch to the Erase 
mode. Therefore, when you paint on the layer mask, it will have the effect of erasing the 
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mask. This is handy for “trimming” overspray of the mask and making your selection 
more accurate. 

The Brush Button 
This button displays the current status of the brush, namely transparency and softness. 
Press this button and a pop-up window appears with brush painting settings. 

In this window, you can configure all the paint brush settings such as Size, Opacity and 
Softness. In the center of the grid there are various presets for quick selection. If you 
have a pen tablet attached, you can also configure Pen Pressure, Radius and Opacity 
levels. 
 

Radial Gradient Mask button
A Radial Gradient Mask is a quick, easy way to highlight the sun, a face or anything else 
on your photo with an easily re-shapable mask to achieve a stunning result. To use this 

tool, simply click the Radial Gradient Mask button which will place a circular gradient 
controls on the image and reveal controls specific to the tool.  
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Moving left to right, each of these icons and tools will be explained below: 

• “Eye” icon  
Use the “Eye” icon to show and hide the mask. 

• Invert Mask icon  
By default the Radial Gradient mask that is created will “protect” the center of the 
circle/oval and any enhancements will be applied outside of the inner circle. Click 
this button to invert the mask so that effects will be applied TO the inner circle. 

• Paint mode icon 
Clicking on the icon that shows two overlapping, filled squares will ensure that any 
effects are applied to mask. 

To change the shape of the Radial Mask, simply tug on the handles located on the inner 
and outer circles.  
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• Erase mode icon 
Clicking on the icon that shows a transparent square on top of a filled square will 
erase the effect on the mask. 

• “X” icon  
Click on the X icon to leave Radial Gradient Mask mode. 

• Checkmark 
Click on the green checkmark to create the mask 

The bands of red indicate the following: 
• 100% opacity of mask is located in the upper strip 
• Strip transparency gradually falls to 0% from the top to the bottom. The middle 

strip is 50% of transparency. 
• 0% transparency is after the lower strip. 

Gradient Mask Tool 
To use this tool, simply click on the button that looks like a grid, which will automatically 
create a Gradient Mask on your layer and reveal controls specific to the tool. A favorite 

tool of landscape photographers, the Gradient Mask allows you to enhance images very 
smoothly with effects only applied to the Gradient. The default setting results in 3 bands 
on your screen with a rotation degree read-out in the center. 
   
To change the shape of the Gradient Mask, simply tug on either of the two outer lines to 
expand or contract the mask. You can also reposition the Gradient or rotate it to suit your 
needs.  

Moving left to right, each of these icons and tools will be explained below: 
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• “Eye” icon  
Use the “Eye” icon to show and hide the mask. 

• Paint mode icon 
Clicking on the icon that shows two overlapping, filled squares will ensure that any 
effects are applied to mask. 

• Erase mode icon 
Clicking on the icon that shows a transparent square on top of a filled square will 
erase the effect on the mask. 

• “X” icon  
Click on the X icon to leave Gradient Mask mode. 

• Checkmark 
Click on the green checkmark to create the mask. 

The bands of red indicate the following: 
• 100% opacity of mask is located in the upper strip 
• Strip transparency gradually falls to 0% from the top to the bottom. The middle 

strip is 50% of transparency. 
• 0% transparency is after the lower strip. 
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Masking Mode: Additional Features 

• While masking or erasing, right clicking of the mouse causes a context window of 
parameter settings of the brush, and includes additional controls for pen pressure 
sensitivity. 

• For handy reference, on the Layers palette on the upper right side of the Side 
Toolbar, you’ll see a thumbnail image of the current mask. 

• To quickly switch between masking and erasing modes, use a hot key - "X" 
• To quickly change the diameter of the brush, use hot keys "[" and "]". It is very 

convenient and greatly speeds up the work. 
• If you hold down the space bar in Painting mode you can switch to Move the image 

mode. 
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Side Bar: Tools   

The Tools section of the sidebar contains 14 control panels which allow you to achieve the 
best possible image results. Each of the panels contains sliders and controls related to 
the Tool. 
 

Aurora HDR 2017 contains the following tools: 

• HDR Tone Mapping - General settings related to the Tone Mapping and 
compression of the image for the original image layer. Note: reverts to Tone on 
additional layers. 

• Color - Color settings such as saturation, temperature and tint. 
• Structure - Adjusts the clarity, structure, micro-contrast of the image, leading to 

a more “crisp” result. 
• HDR Denoise - Reduces noise and artifacts in the image created by the HDR 

image merge process, as well as making the overall image smoother. 
• Image Radiance - Provides for an overall “dreamy” look to your image by 

softening image luminescence, and increasing contrast & saturation. 
• Polarizing Filter - Provides more color depth and cuts atmospheric haze, 

resulting in richer, bluer skies. 
• Details - Increases image details globally or in highlights and shadows. 
• Glow - Provides a glow effect to the image, primarily in highlights. 
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• Top & Bottom Adjustment - Permits separate adjustments of exposure, 
contrast, vibrance in the upper and lower areas of the image. 

• Tone Curve - Represents the tonal range of the image along a diagonal line which 
can be adjusted by clicking and dragging. May be adjusted globally or by RGB 
channels. 

• HSL - Adjusts the hue, saturation and luminance of a particular color channel. 
• Color Toning - Shadows and highlights color tinting for stylized visual effects. 
• Vignette - Provides a vignette effect for finishing images to a professional level. 
• Layers - Provides options for Opacity, Blend, Source and Texture Maps in one 

handy pane. 

How to use the Image Enhancement Tools 

Each major adjustment tool in Aurora HDR 2017 is contained within a “control pane”, 
generally consisting of a header with the name of the tool, along with a set of sliders or 
other controls related to this tool. 

Common Actions with every tool include the following: 

• Clicking on the header (the section name) hides and reveals this section. 

• Clicking on the orange circle to the left of the section name enables or disables the tool, 
allowing you to view the image without the effect of this tool. 

• When the cursor is on the title icon, an icon with two arrows appears. When you click 
on this icon, all the sliders of this section are restored to their default state. To cancel 
this action, you can click the "Undo" button. 

HDR Tone Mapping 
This tool gives you control to adjust the Tone Mapping process. Tone mapping (or 
“compression”) converts the wide dynamic range image into one that is more narrow and 
can be displayed on a computer monitor. It’s a great place to start your HDR journey. 

Note: The tool is available only on the first layer! Subsequent layers will include 
additional controls described below in the Tone control panel section.  
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Slider Description

HDR Look  
The HDR Look slider is a single slider that adjusts a variety of controls including lighting 
effects and detail, and includes a special ability to configure balanced image brightness 
without getting completely white or completely black areas. The overall brightness and 
sharpness of the image increases when you move the slider to the right. This has the 
effect of making the image less realistic and more classically the look a lot of people 
associate with HDR. Moving the slider to the left lets you decrease the settings, achieving 
a more realistic look. 

Tool Remarks 
This effect only works on the original layer of the document and by default automatically 
attempts to present a realistic, balanced result right from the start. In most cases you 
need not change this slider. 

Tone 
This control panel is responsible for the overall tone setting of the image. On the original 
layer of the image, it will contain an additional HDR Tone Mapping control slider. 
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Sliders Description 

Exposure 
Adjusts the global luminance of the image. Moving this slider to the left results in a 
darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). 

Contrast 
Adjusts the contrast of the image. Contrast is the difference in luminance or color that 
makes an object in an image distinguishable from another. Practically speaking, contrast 
is determined by the difference in the color and brightness of an object in relation to 
other objects within the same field of view. 

Smart Tone  
This slider adjusts the overall brightness of image properly. When moving to the right, 
the image is more vivid, but it does not work when bright areas become white, as in the 
ordinary exposure. And when you move the slider to the left, the image becomes darker 
but there are no completely black areas. This is a very powerful and balanced image 
brightness tool. 

Highlights  
Adjusts the brightness of the brightest areas of the image. Moving the slider to the right 
cause very bright areas to become brighter, while moving the slider to the left, makes 
them darker. 

Shadows  
Adjusts the brightness level of the darkest areas of the image. Moving the slider to the 
right will cause such areas to become brighter and additional details will appear. When 
moving to the left, such areas become darker, and the number of shadow areas in the 
image generally increases.  

IMPORTANT! If you greatly increase the lighting of Shadows, that image will be much 
softer. 

Whites  
Adjusts the white point of the histogram and white tones in the image. When moving to 
the right, the brightest tones will become brighter while the histogram stretches to the 
right. Moving the slider to the left will cause white tones in the image to become darker 
and the histogram to compress to the left. 

Blacks  
Sets the black point of the histogram or black tones in the image. Moving the slider to 
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the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, black become darker and the histogram stretches to the left. 

Tool Remarks 
Whites and Blacks can be used to fine-tune of contrast of the image. 
Strong raised Shadows can lead to a strong dark areas and loss of contrast. 

A recommended workflow is to start with a light touch with Exposure and Contrast, 
then Smart Tone. Then proceed to setting Shadows and Highlights and finally fine 
tune the contrast of the image using the Whites and Blacks sliders. 

Color 
The Color section gives you complete control over colors and color saturation of the 
image. 

Sliders Description 

Temperature & Tint. Sets the color temperature of the image. If the overall tone of an 
image is too warm or cold, it can be changed using these sliders relative to the color 
spectrum shown on the sliders.  

Saturation. Adjust the color saturation of the image. This is a standard slider, similar to 
many other applications. Moving the slider to the right will cause the colors in the image 
to become more saturated, while moving the slider to the left will cause the picture to 
become black and white. 
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Vibrance. This slider is a "Smart Saturation” control. In general, its effect is similar to 
Saturation with the difference that it increases less vibrant colors stronger and has a 
weaker effect on more vibrant colors. This allows you to get more realistic and less 
saturated colors the picture. This slider can be used in conjunction with the Saturation to 
enhance the secondary colors. 

Color Contrast. Enhances the color contrast in the image. Color contrast specifically 
refers to contrast that is created between differences based on colors (vs. luminance). 
The strongest is, the more contrast between primary and secondary colors. 

Tool Remarks 
Vibrancy сan be used in conjunction with Saturation to make secondary colors pop a 
little more. Application of Color Contrast is also recommended to obtain realistic contrast 
and color saturation of the picture. This slider is very helpful, especially if the color 
temperature is incorrect - make any corrections here at the very start of editing, before 
further image adjustment is applied. 

Structure 
This tool allows adjusting of image detail and clarity. Using this tool you can get a classic 
HDR effect with great detail or get a smoother picture with less detail. This is the main 
tool to increase micro-contrast of the image and visualize more details in the image. 
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Sliders Description 

Clarity 
Adjusts the overall image clarity. By increasing the value of the slider, the number of 
global visible components increases. If values are much larger, halos may appear on the 
contrast edges of the image. Best practice is to not raise the value of the slider above 50. 

HDR Structure Section  
Increases image detail by revealing of the structure and texture of the surfaces in the 
image. This micro-contrast enhances the image and hidden details appear. 

• Amount - The strength of the effect. By moving the slider to the right, the 
amount of visible detail in the image increases. Moving the slider to the left will 
cause the image to lose detail and flatten. The “zero state” in the middle means 
that the amount is not applied by default. 

• Softness - Controls the overall softness of structure and textures in the image. 
Moving the slider to the left will cause parts of the image to become less smooth 
and more unrealistic. This produces the so-called classic view of the HDR effect. 
Moving the slider to the right, on the contrary, the details become more global and 
the image is more realistic. This is very useful slider to adjust realistic details. 

• Boost - Adjusts the overall display of details. When moving the slider to the left, 
the images will become more realistic and “calm." Moving the slider to the right 
will accentuate details and make the image more unrealistic. 

HDR Detail Section  
This section amplifies micro-detail within the image. These are small details that form the 
surface of any object in the image. They can further enhance details of the image and 
provide a more vivid artistic HDR effect, however it can also make the image very noisy. 

• Amount - Increases micro-details and contrast. 
• Softness - Affects the general "softness" and realism of the photo. Moving the 

slider to the left will cause the image to become very finely detailed and 
unrealistic. 

Tool Remarks 
Increasing the values of detail can cause an increase of noise in the image. 
In case of high Clarity values, ghosting of the image may appear and so we do not 
recommend raising the value above + 50. 

In most cases, HDR Detail adds a lot of noise in the image. To get a realistic HDR, do 
not apply HDR Detail 
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HDR Denoise 
This tool slightly blurs the image and reduces the amount of noise and any image 
artifacts caused by merging multiple exposures together. However, special algorithms 
also attempt to preserve edge detail if possible. It can be used to reduce the amount of 
noise which may have been caused by increasing detail within the HDR Structure section. 
 

Sliders Description 

Amount  
The strength of reduction of small noise in the image. Moving the slider to the right will 
increase the noise reduction. Note: the Opacity slider must be moved above 0 to notice 
results. 

Smooth  
This slider allows you to make the image more blurred which has the effect of creating a 
less detailed and noisy image.  

Super Smooth 
This slider allows you to make the image even more blurred and really trends towards a 
stylized look. This is a very aggressive effect. 

Opacity  
Relates to the transparency of this effect. Moving the slider to the left removes the 
impact of noise reduction, while moving to the right allows the full effect of the de-noise 
control to be shown. 

Tool Remarks 
It’s helpful to apply this tool not to the entire image, but locally: Create a layer in which 
you’ll apply the effect, and then, using a mask, brush only the area where the effect 
should be applied. For example, if the noise is very noticeable in the sky, then, using a 
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mask, apply the effect to the sky. This effect should never be applied to the entire image 
- otherwise too much detail will be lost. 

It is better to leave a little transparency effect that preserves a little noise in the original 
image to increase its realism. Best Opacity value is in the range of 70 to +90. 

The effect can also be used for aggressive blurring of local areas in the picture, such as 
the sea or a flowing stream of water. It will make them softer. 

Image Radiance 
This tool provides a soft glow effect to the image, adding more vibrant colors with an 
increased global contrast. Moderate use of Image Radiance can give you more 
interesting, entertaining “dreamy” images. 

Sliders Description 

Amount. Effect strength. For a moderate effect and a more realistic image, keep the 
values in the Amount to +40. If the Amount value is 0, then the effect is not applied. 
Move the slider to the right to increase Amount. 

Smoothness - Controls the softness of the effect. 

Brightness - Controls the brightness of the effect. 

Smart Colorize - Adjusts the color saturation effect applied to the image. 

Warmth - Adjusts the hue of the effect towards the warm end of the scale. 
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Tool Remarks 
At a low setting, this effect will give the image more contrast and can increase color in 
the image. Use the Smart Colorize slider for better control. 

Polarizing Filter 
This tool emulates a polarizing filter, popular in professional photography. The effect will 
produce deeper blue skies and more contrast in clouds. With a light touch of this filter, 
almost any landscape image can be improved. 
 

Slider Description 

Amount. Effect strength. If the Amount value is 0, then the effect is not applied. Move 
the slider to the right to increase Amount. 

Tool Remarks 
It is not recommended to use this tool on night photos or images with no sky in them. 
Most times, keeping the effect intensity under +50 will yield the best results. 

Details 
This tool allows you to control the details of the image, making it more clear and sharp, 
or vice versa, softer. This tool is useful for improving the overall quality of the image as 
well as to increase the quality of the images that will be used in high resolution, such as 
for printing. Increasing the sharpness can also compensate for lower quality optics used 
to make the captured image.  

Innovative technologies allow the Details tool to improve image sharpness without 
increasing digital noise or creating unnatural ghosting or halos in the image. This is a 
very powerful tool to improve the quality of images. 
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Sliders Description

The tool has 3 tabs with the same set of sliders. 

Global 
Sliders in this tab control the details of the entire image. 

Highlights 
Sliders in this tab control those parts of the image that are only on the brighter side of 
the tonal range in the image. The rest of the image remains intact. 

Shadows 
Sliders in this tab control parts of the image that are in the darker side of the tonal 
range, without affecting the brightest tones in the image. 

Each tab contains the following sliders. 

• Small sets sharpness of fine details. At 0, the effect is not applied. Moving the 
slider to the right will intensify the clarity of small details, while moving to the left, 
on the contrary, somewhat washed out the fine details. 

• Medium sets medium-sized parts sharpness. At 0, the effect is not applied. 
Moving the slider to the right increases the sharpness, while moving the slider to 
the left - decreases it. 

• Large sets sharpness of global contours of objects in the image. At 0, the effect is 
not applied. Moving the slider to the right increases the sharpness, while moving 
to the left - decreases. 

Masking is a separate slider. This slider controls the zone of detail amplification. When 
moving the slider to the left, the number of zones increases and the image becomes 
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more detailed. When moving to the right, the number of granularity zones is reduced. 
Optimal masking comes from a setting in the range from 30 to 70. 

Tool Remarks 
A moderate increase in Small and Medium has positive impact on the sharpness and 
quality of any image. There is often no need to demonstrate all details in the image.  

In bright areas, such as the sky and light clouds, unnecessary detail will reduce realism. 
The dark areas often need more detail. Therefore, it is always better to strengthen 
Details in the shadows than lights. 

Tip: you can reduce the sharpness in bright colors by moving the slider to the left side of 
the Details in Highlights tab and increase the amount of detail in dark colors by moving 
the Details sliders to the right in the Shadows tab. The best way to increase sharpness 
is with Small and Medium details sliders. It is often not necessary to work with Large 
Details. 

Should you desire an image that is soft, you can achieve that effect by moving the Detail 
sliders to the left.  By default all sliders are at 0 and at that setting have no effect. The 
effect is only visible after moving sliders to the left or right. 

Glow 
The Glow tool adds auras on the picture. The effect finds the brightest areas of an image 
and adds bright halos to it, having the effect of shining. This effect can be used to give 
the photo a "romantic" view or create a fog effect. This effect looks good on night photos 
to accentuate glow halos around light sources such as street or building lights.  
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Sliders Description

Amount 
Sliding this control to the right increases the strength of the glow around areas of high 
brightness. 

Smoothness 
This slider controls the size of halos around bright areas. Moving the slider to the right 
increases the size of the halos. 

Brightness 
This slider analyzes the image and determines where halos will be created, letting you 
choose those areas of brightness that should be lightened up. Moving the slider to the 
left ensures areas of maximum brightness will be selected. This locates the glow just 
around the brightest areas. Moving the slider to the right will include darker areas to 
glow. Moving it all the way to a value of 100 will light up the entire image. 

Warmth  
By default, a neutral white color is used for the glow in the middle of a halo. This slider 
allows you to select a specific hue for the glow, according to the cool-to-warm spectrum 
shown on the slider. 

Tool Remarks 
This effect can be a powerful tool for creative photo processing. When you move the 
Brightness slider to 100 and increase Amount, you get a misty or foggy effect in the 
picture. By increasing the Amount, detail in bright areas is not lost, but rather 
“highlighted.” 

Top & Bottom Adjustment 
This tool is a simulation of an analog filter to specify different brightness in the picture 
vertically - Graduated Neutral Density Filter. This effect is widely used in landscape or 
architecture photography with a distinct horizon. The effect flexibly and separately 
controls the brightness and other aspects of the top and bottom of the image.  

This enables you, for example, to lower the brightness of the sky and raise the 
brightness of the foreground. Thus, your image can be significantly improved without 
resorting to creating layers and masking. 
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Sliders Description

Note: The explanation of controls are the same for Top & Bottom sections of this panel. 

Exposure - controls the brightness of the image. Moving the slider to the left will make 
it darker and to the right brighter. 

Contrast - adjusts the contrast of the image. Contrast is the difference in luminance or 
color that makes objects in an image distinguishable from another. 

Vibrance - This slider increases less vibrant colors stronger and has a weaker effect on 
more vibrant colors. This allows you to get more realistic and less saturated colors the 
picture. 

Warmth - Adjusts the hue of the effect towards the warm end of the scale. 

Blend - the transition bandwidth between the Top & Bottom. Moving the slider to the 
right will increase the Blend value, making the transition between the values of Top to 
Bottom wider. Moving the slider more to the left will decrease the blend value creating a 
sharp transition between Top and Bottom. Handy guidelines will appear on your image to 
visually show you the transition blends. 
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Shift - Using this slider will adjust the vertical location of the transition zone between 
Top and Bottom in the photo. 

Rotation - Moving this slider rotates the transition zone. 

Tool Remarks 
This tool is best suited for landscape shooting with a strong horizon line. With it, you can 
lower the brightness of the sky at the top, and then, using Shift / Rotation / Blend orient 
the strip of brightness transition between heaven and earth approximately at the level of 
the horizon. 

Tone Curve 
This tool is a powerful "Curves" that may be present in other applications. It can help you 
manually fine-tune the brightness and contrast of the image. 

Customizable tabs that allow you to switch curves are located at the top. You can switch 
between RGB (all curves merged into one) or access them separately between Red, 
Green, Blue channels. At the bottom there are sliders that let you adjust black and white 
points of the histogram (the leftmost and rightmost sliders), as well as the middle bend 
of the curve (the central slider). 

Tool Remarks 
Many, many articles are available on the Internet for information on using this tool. 
Generally moving a slider down will darken that “channel” and moving it up will lighten 
the channel. Experiment and have fun! 
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HSL (Hue, Saturation, Luminance) 
This tool allows for separate adjustment of the hue, saturation and brightness of the 
main color channels in the image. 

Sliders Description

There are 3 tabs present in the Color Filter panel. 

Hue - a set of sliders to adjust the hue or basic color shades of your image. Sliding the 
control further to the right results in a more intense hue. 

Saturation - a set of sliders to adjust color saturation. Sliding the control further to the 
right results in a more intense color. Of course, moving to the left removes color to the 
point where -100 will make the image appear black and white. 

Luminance - set of sliders to adjust the brightness of the colors. Sliding the control 
further to the right results in a brighter color within the image. The further to the left, 
the darker the image. 

Tool Remarks 
This is a powerful tool for fine-tuning of colors in the image as well as a means for 
creative image processing. It is found in several other popular photo apps such as Adobe 
Lightroom. Examples of using this tool: 

• The sky is mostly blue in the photos. Therefore, lowering the brightness of blue colors 
in the image can cause more dark and deep blue of the sky. 
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• Reducing the tone for some colors (move the slider to the right in Saturation tab), and 
leaving it for the other can cause a dramatic effect on the selective color in photos. 

• Raising the yellow color (move of the slider to the right) can significantly improve color 
saturation of autumn foliage on the photos. 

Color Toning 
This tool affects the color toning of images. The color shade in the Highlights area is for 
the light areas in the image and the Shadows area color shade is for the dark areas. The 
effect can significantly increase the visual appeal of images, and is often used for 
creative artwork or to simulate analog photography techniques (e.g. a vintage look) 

Sliders Description

Highlights Section - Sets the color for the bright colors in the image. 

• Tint.  
Shade selection. The slider movement to the left and right will change color based 
on the slider spectrum shown. Whatever color you’ve selected appears in a colored 
rectangle on the left of Tint. You can also click on the color rectangle and a Color 
Picker window will appear. 

• Saturation.  
This slider lets you choose the saturation level of the Highlights color shade. If the 
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value of saturation = 0, white is used and toning is not noticeable. Therefore, to 
use color, you must choose both Tint and Saturation. 

• Protection. 
This slider controls how white colors in the image are toned. The Protection value 
100% ensures whites remain whites. The Protection value 0% completely tints the 
whites in the image in the selected color for highlights. Anyplace in-between 
adjusts the value of color appropriately. 

Shadows - Sets the color for the dark tones in the image. 

• Tint.  
Shade selection. The slider movement to the left and right will change color based 
on the slider spectrum shown. Whatever color you’ve selected appears in a colored 
rectangle on the left of Tint. You can also click on the color rectangle and a Color 
Picker window will appear. 

• Saturation.  
This slider lets you choose the saturation level of the Shadows color shade. If the 
value of saturation = 0, white is used and toning is not noticeable. Therefore, to 
use color, you must choose both Tint and Saturation. 

• Balance. 
Sets the balance between light and dark tones. If you move the slider to the right, 
more tones are considered bright and therefore the color chosen for the bright 
areas (Highlights) are emphasized in the photo. Move to the left and more tones 
are considered dark and the color chosen for dark tones (Shadows) are 
emphasized in the photo. Thus it is possible to balance what color you want to 
have for toning the image. 

• Amount. 
Adjusts the power of the effect. 

Tool Remarks 
The best results are achieved if you use the opposite colors to the bright and dark areas, 
for example: yellow and blue, green and purple. 

Use warm tones for light colors and cool ones for the shadows. Only light or only dark 
areas of the image can be toned. To avoid toning of certain areas, simply set Shadows or 
Highlights saturation parameter to 0. The color is not applied. 

Page !  of !50 67



Vignette 
A Vignette darkens or lightens the edges of your image. This is quite an old technique to 
emphasize the accents on photos. The effect typically leaves the central area unaffected 
while the edges are shaded or lightened. Aurora HDR goes further by letting you place 
the center point of the vignette anywhere in the image you like. 
 

Sliders Description

Amount 
Strengthens the darkening around the edges of photos. In position 0, the effect is not 
applied. Move the slider to the left side of the picture to give more shading to the edges, 
while moving the slider to right will brighten the edges. 

Size  
Size of the obscured area. Moving the slider to the left will increase the area of 
darkening. Moving the slider to the right will reduce the area of darkening. 

Roundness  
This slider changes the shape of the shaded area. 

Feather 
This slider sets the smoothness of the transition between the area of shading. 

Inner Light 
This slider increases the brightness in the central region which is not affected by shading. 
It allows you to create a contrast effect. 
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Place Center Button  
This control adjusts the center of the effect. By default, the center of shadowing effect is 
in the center of the image. With this button you can shift the focus from the center of the 
image to any other place. Click on the button Place center which will turn the cursor into 
a “target sight.” Click this anywhere on the image to set the new center of your shading 
effect. 

Reset Center Button  
This button sets the center of the effect back on the center of the photo. It is necessary, 
if we shift the center of the effect to a different place and we want to set it back to the 
center of the photo. 

Tool Remarks 
This tool allows you to highlight key points in the photo, making it more interesting. A 
slight edges shading always provokes the viewer's eye to consider the lighter central part 
of the photo. You can also move the center to focus attention on some objects that are 
not in the middle of the picture. For a realistic picture, don’t lower the Amount below -50. 
As a rule, this effect is used only with darker shading. Highlights are rarely used except 
for some vintage looks. 

Layer 
The Layer pane provides options for Opacity, Blend, Source and Texture Maps in one 
handy place and works on the current layer. 

Sliders Description

Opacity 
Adjusts the transparency of the current layer. 

Page !  of !52 67



Blend  
Allows you to set the Blend mode of the current layer.  

Source 
Permits you to change the Source file of the current layer - either Original Image or one 
the HDR exposures (as explained earlier). 

Texture Map  
Sets the scaling of a layer that contains a texture. 

SideBar: Presets 

Presets allow you to make instant changes to your HDR image with one click of a button. 
Each preset is made up of all the saved settings (sliders) located in the right sidebar. For 
each layer, a different preset can be applied, which can make for some creative results! 

Clicking the green Preset button at the bottom right of the Aurora workspace or the 
Preset icon in the Top toolbar shows/hides a “filmstrip” panel at the bottom of the 
application which displays the image preview of each preset available in a given category. 
Once the filmstrip is visible, clicking on the round button on the right side will reveal the 
categories. 

To select the current preset from the filmstrip, simply click on the preview image. All the 
preset settings of the current preset are immediately applied to the image. An orange 
frame highlights the current preset and, as your mouse is positioned over the preset an 
opacity amount slider is revealed, with the default set to 100% opacity. Move the slider 
to the left to reduce the amount of the effect. To view all the presets in a given category, 
simply use the arrow keys on your keyboard or the horizontal scrollbar located at the 
bottom of the Aurora 2017 window. 

Preset panel functions 

1. The Presets button and the Presets button in the Top toolbar displays and hides 
the presets filmstrip bar on the bottom of the window. 

2. Clicking on the round button on the right of the Presets filmstrip will display a 
window with a grid of preset categories. The current category will be highlighted 
and will also be the name of the category (e.g. “Basic”, “Indoor”, etc.). As stated 
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before, the filmstrip will contain previews for each of the presets in the chosen 
category. 

Preset Categories  

There are default and custom user presets: 

1. Default presets are those that came originally installed into the application. 
2. Custom presets are created by the user. 
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Application preset categories: 

1. Basic - versatile built-in presets suitable for all kinds of images. 
2. Realistic HDR - suitable for images for which a realistic style is desired. 
3. Landscape - suitable to the nature and landscapes. 
4. Dramatic - a set of creative presets for stylized photos.  
5. Trey’s presets – signature presets by Trey Ratcliff.  
6. Captain Kimo presets - signature presets by Kim Seng (AKA “Captain Kimo”). 
7. Serge Ramelli presets - signature presets by Serge Ramelli. 
8. Indoor - suitable for shooting of interiors as well as objects. 
9. Architecture - suitable for architecture, cities, and urban landscapes. 
10. Favorites - a set of presets that were listed in the favorite or selected. 
11. Custom - is a set of user-created presets. 
12. All Presets - a category includes all the presets in alphabetical order.  

More with Presets 

1. Add to your favorite or chosen presets  
To highlight any preset as a favorite, click on the star in the lower right corner of 
the image preview in the presets filmstrip. It will change color to bright yellow. Re-
click on the star to de-select the preset as a favorite. 
 

2. Additional capabilities for user presets  
There are additional features for user presets that are not available for the built-in 
presets. To access the context-sensitive menu for a user preset, Control-click on 
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the preset or click on the right button of the mouse while hovering over the preset 
image. 
 

• Show in Finder. Opens a Finder window with the currently selected preset 
file. This allows you to copy the preset and pass it on to someone else. 

• Delete. Deletes the current user preset. 
• Rename. Renames the current preset.  
• Export. Saves the current preset file to a location of your choice. 
• Update with Current Settings. To over-write or re-save the preset with 

the current state of the sliders in the sidebar. 

Export and Import of Presets 

You can freely export your own presets and import another person’s presets into your 
application. 

To do this, select the menu item File -> Show Presets Folder which displays the folder 
with the current preset of the application. From there, you can easily add files (presets) 
to this folder. All presets in this folder appear in the Custom category and the All Presets 
category. 

• To export, you can simply copy files from this folder. 
• To import, just copy the files into the new presets folder. 
• To delete a preset, you can simply delete the preset file in the folder. 
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Adding a Custom Preset Pack 

Occasionally Macphun or other professional photographers will release a collection of 
presets, called “Packs”. When you import a Custom Preset Pack, it will create a new 
category in the Presets category window, and display any associated presets therein. 

To add a Custom Preset Pack, select the menu item File -> Add Custom Presets Pack. 
An open dialog will be displayed, allowing you to choose the Pack you wish to add. 

Creating a New User Preset 

• To create a new custom preset, press the + icon to the right of the Presets button. 
This will save the current state of all the sliders in the Side Bar. 

• Alternatively, use the File -> Create Preset menu. 
• After clicking on the button or choosing the menu item, enter the name of the new 

preset. The newly created preset appears in the Custom Presets and in the All 
Presets categories. 

Batch Processing 

Batch Processing is a powerful way to open, edit and save many images at once, saving 
time and effort. The tool is ideal for working on single images as well as many sets of 
bracketed exposures. Aurora HDR 2017 will automatically group brackets based on EXIF 
data stored in each image including exposure settings, aperture settings, ISO levels, lens 
data and time shot. 

To begin a Batch Processing session, either access it from the initial Open Aurora HDR 
2017 Open dialog, or… once the application has started from File -> Batch 
Processing… or by clicking on the Batch Process button in the Top Toolbar. 
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Assuming you’ve accessed Batch Processing by clicking on the icon, you’ll be presented 
with a dialog box to which you can drag files or folders (which contain files). You can also 
click the Load Images button in the lower left corner to bring up the Open file dialog. If 
the “Include Subfolders” option is on, and you’ve added folders, then then Aurora HDR 
2017 will search for all images in every subfolder of the added folders. 

Images can be processed as single images, or as HDR Brackets. To switch the image 
processing type, you have to press the appropriate button at the bottom in the middle of 
the window. HDR Brackets mode is set by default, which will automatically sort and group 
exposure brackets and process them accordingly. If the Single Images mode is selected, 
all the images will be treated as independent files and processed separately. 

After the images you wish to process have been selected, press the Continue button to 
reveal options and settings for Batch Processing. 
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Batch Processing Options 

The Batch Processing feature is very versatile and contains many options that you can 
conveniently apply to a large set of images. Moving top to bottom, here are the options 
you have available:  

• Preset  
The Preset panel on the left side of the window displays the Batch Processing 
presets that are available. To save current batch processing options as a preset, 
simply press the Add button at the bottom of the Preset panel and name your new 
preset. Thereafter, the preset will be saved and listed in the Preset panel. Because 
Batch Processing has many parameters, it’s helpful to create a custom preset to 
save time later. Note: the Batch Presets are not related to the image enhancement 
presets found in the main Aurora HDR 2017 software, BUT can apply an 
enhancement preset as part of the batch operation. 
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• Export Location  
This option lets you choose where processed files will be saved. You can save them 
in their current location or browse to select another folder. When you’ve made a 
choice, the file “path” will be displayed. Note: Because it is possible to overwrite 
your original files, it is a good practice to save your batch-processed files into a 
new folder separate from the original files. 

• HDR Settings  
The options presented here mimic the HDR Merge dialog of the main Aurora HDR 
2017 software. Select the settings desired by clicking the appropriate checkboxes. 

• Select Preset 
Use this option to select an image enhancement preset to be applied to each image 
or merged HDR image in the batch operation. 

• File Settings  
The options in this area mimic choices normally found in the Export feature of 
Aurora HDR 2017. You can select file format, image quality, color profile, resize and 
sharpen quality in one convenient step. 

• File Naming  
Aurora HDR 2017 has very flexible file naming options. You can add a prefix and 
suffix, choose from a variety of base names and even select the case of the letters. 
This gives you tremendous flexibility to organize your files as part of the batch 
processing operation. 

After selecting your desired Batch Processing options, press the Process button in the 
lower right of the window to begin the operation. This will display a processing window 
showing progress. 
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To return to the Image Selection window and select different images prior to beginning a 
Batch Processing operation, press the Back button in the lower left of the window. To 
cancel Batch Processing altogether, click the “X” in the upper left corner of the window. 

Finishing Options 

Crop Tool 

This feature allows cropping the picture and the ability to align (straighten) the horizon in 
the image if that is not horizontal.  

To switch to Crop Tool, click the Scissors button in the top toolbar or press the "C" key. 
After pressing this button, the application enters Crop Tool Mode. 

An Info Bar displays all functions for cropping an image. The image is displayed with a 
grid that represents the ratio chosen in the Ration dropdown menu. 

Possible actions with the Crop Tool: 
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• Resize.  
Click on any of the edges, or the resize handles, and drag them to resize the 
cropping rectangle. 

• Resize by Dimension. 
Clicking on the numbers to the right of the Size label allows you to enter precise 
dimensions for your image to be cropped. 

• Move.  
Click inside the image crop area and hold the left mouse button or the spacebar to 
reposition the image “behind” the cropping rectangle. 

• Rotate.  
Click on the Angle readout to reveal a drop-down slider for adjusting the angle of 
the image up to 45 degrees in either direction. 

Once you’ve cropped the image so that what you want to remain after cropping is visible 
wishing the cropping rectangle, click the Apply button. To cancel this action press 
Cancel. If you don`t like the result, you can easily undo the cropping by pressing the 
Undo button. Hence cropping is a safe operation that can be easily undone. 

Saving and Exporting 

To save your work in progress, press Cmd + S on your keyboard or choose the File > 
Save… menu item.  Your work is saved in its current state so that you can later continue 
from the same point. The file is saved in the proprietary Aurora HDR 2017 file format and 
cannot be opened with another application. For other software to use images created 
using Aurora HDR 2017, you’ll need to Export the file (see below) 

To save the results of your work to an image file, use the File -> Export to Image 
menu item or the key combination Shift + Cmd + E. You can also click on Export/
Share button on the Top Toolbar and click on the green Export to Image button. 

When you export a file, you can save in a variety of file formats including JPG, TIFF, PNG 
and even PSD. Each file format has its own unique set of parameters which are standard 
macOS system options.   

Other options you have within this pop-up is the ability to share to several other services 
or open the file for further editing within other software. 
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Share to Apple Mail, Apple iMessage, Twitter, Facebook, Flickr, SmugMug or 500px. The 
latter three are online gallery and print services which are very popular. You will need to 
separately have an account on these services to access them within Aurora HDR 2017 
 

Open in any of the Macphun Creative Kit apps, plus iPhoto, Aperture, Photos for Mac, 
Photoshop, Lightroom and Photoshop Elements. 
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Aurora HDR 2017 also supports several specialty file formats unique to HDR, 
including .HDR, .EXR and Floating Point .TIF. These formats provide terrific 
interoperability with other powerful applications.  

 

Extra Features 

The application includes many user-friendly features to simplify your work. 

Double click on any slider name resets the value to the default. In most cases, double-
clicking returns it to 0. 

If you press and hold the Option key and click on a slider value in the sidebar, 
moving the cursor to the left and right will let you set the values of the slider with high 
accuracy. Slider sensitivity is higher than with its normal movement. This allows you to 
fine-tune to small numeric values. 

Pressing the "F" button enables full-screen viewing of your image. This allows you to 
look at the result conveniently without the interface. Press any key to return to normal 
mode.  

To quickly open a folder of source files of an HDR image bracket in the Finder, you can 
use the File -> Show in Finder… menu item. 
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The image background can also be changed. By default it is dark gray. But it can be 
lightened, as desired. Select the menu item View -> Background or right-mouse click on 
the image background to select a new background color for the image. 

Single View Mode, accessed from the View menu, displays adjustment controls for only 
the selected tool in the Tools Sidebar. With this viewing option, all the tools, except the 
current one, are closed. Click on a different tool and the current one will be closed and 
the new one opened. In this mode, only one control is visible, cleaning up the sidebar 
interface significantly. 
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Keyboard Shortcuts 

General 

“F” -  View the current image in full-size screen. Return to the application by pressing any button.

 “\” - Activates before/after comparison. When the key is pressed, the original image will be shown. 
The original image can be either the original tone-mapped result or a middle image in a bracket series. 
The last option is set by default. To change this option, simply go to the View > Compare With fly-out 
menu. Releasing the key will reveal the enhanced image.

“;” - Activates side-by-side comparison mode where the original image is on the left side and the 
edited result will be on the right side. To exit the mode press the “;” button again.

“Tab” - Show/hide the Preset panel at the bottom of the window.

“C” - Enter the Crop tool.

“G” - Activates the Gradient Mask tool.

“R” - Activates the Radial M Tool.

“L” - Activates the Luminosity Masking Tool.

“J” - Show/hide the display of “hot” and “cold” pixels. These are completely black and white pixels on 
an image.

“Cmd + B” - Opens Batch Processing mode.

“Shift + Cmd + E” - Image exporting to the file

“Shift + Cmd + F” - Show current edited file in Finder.

Mask editing 

“[”  - decrease the brush radius

 “]”  - Increase the brush radius

 “Shift + [”  - Decrease the brush softness

“Shift + ]”  - Increase the brush softness

“X” - Switching between painting / erasure modes
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“Cmd + I” - Invert the layer mask

“Cmd + Delete” - Clear the mask. Make it empty. It means, that the layer work result 
will be invisible, until you paint something with the brush.

“/” - Show current layer mask in the form of red transparent image imposition.

“Space” - moves the image in the painting mode.

Keeping Aurora HDR Pro up to date! 

Aurora HDR 2017 has a handy automatic update feature to address updates, new 
features, enhancements and bug fixes. To ensure you’ve got the latest release, open the 
software and choose the Aurora HDR 2017 -> Check for Updates… menu. 

This will launch the Macphun update service and automatically grab any updates you 
need. Follow any prompts relating to installation and/or restarting the software. You may 
also need to input your Administrator Password and update the Plug-ins for your other 
applications. 

 

Thank you.  

If you have questions, contact Aurora HDR 24/7 support at support@aurorahdr.com. 
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